Simulation of Pulse Propagation Considering Linear and Nonlinear Effects in a
Single Mode Optical Fiber

by
Muhammad Hasibul Hossain

MASTERS OF ENGINEERING IN INFORMATION AND COMMUNICATION TECHNOLOGY

Institute of Information and Communication Technology
BANGLADESH UNIVERSITY OF ENGINEERING AND TECHNOLOGY
2016
The project report titled “Simulation of Pulse Propagation Considering Linear and Nonlinear Effects in a Single Mode Optical Fiber” submitted by Muhammad Hasibul Hossain, Student No: 0411312030, Session: April/2011, has been accepted as satisfactory in partial fulfillment of the requirement for the Masters of Engineering in Information and Communication Technology (ICT) held on February 9, 2016.

BOARD OF EXAMINERS

1. Dr. Md. Saiful Islam
   Professor
   Institute of Information and Communication Technology
   BUET, Dhaka – 1000

2. Dr. Md. Rubaiyat Hossain Mondal
   Assistant Professor
   Institute of Information and Communication Technology
   BUET, Dhaka – 1000

3. Dr. Hossen Asiful Mustafa
   Assistant Professor
   Institute of Information and Communication Technology
   BUET, Dhaka - 1000
CANDIDATE’S DECLARATION

It is hereby declared that this project report or any part of it has not been submitted elsewhere for the award of any degree or diploma.

___________________________
Muhammad Hasibul Hossain
Dedicated
To
My parents
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>i</td>
</tr>
<tr>
<td>Board of Examiners</td>
<td>ii</td>
</tr>
<tr>
<td>Candidate’s Declaration</td>
<td>iii</td>
</tr>
<tr>
<td>Dedicated To</td>
<td>iv</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>v</td>
</tr>
<tr>
<td>List of Figures</td>
<td>vi</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>vii</td>
</tr>
<tr>
<td>Abstract</td>
<td>viii</td>
</tr>
<tr>
<td>Synopsis</td>
<td>ix</td>
</tr>
</tbody>
</table>

## Chapter 1

### Introduction

1.1 Introduction

1.2 Fiber impairments and importance of simulation

1.3 Objectives with specific aim

1.4 possible outcome

1.5 Methodology

1.6 Outline of this report

1.7 Summary

## Chapter 2

### Fiber properties and Pulse Propagation

2.1 Introduction

2.2 Classification of optical fibers

2.3 Material and doping

2.4 Fiber impairments

2.5 Attenuation

2.6 Fiber attenuation mechanisms

2.7 Dispersion

2.8 Kerr effect

2.9 Self Phase Modulation

2.10 Cross Phase Modulation

2.11 Four wave Mixing

2.12 Stimulated Scattering

2.13 Stimulated Brillouin Scattering (SBS)

2.14 Stimulated Raman Scattering (SRS)

2.15 Pulse propagation through the fiber

2.16 Summary

## Chapter 3

### Mechanism of Dispersion and Nonlinearity

3.1 Introduction

3.2 Dispersion in Single-Mode Fibers

3.3 Group Velocity Dispersion (GVD)

3.4 Material Dispersion

3.5 Waveguides dispersion
Chapter 4
Simulation Environment and Simulation of Optical fiber Properties

4.1 Technologies Used
4.2 How to start MATLAB
4.3 Building the Simulation
    4.3.1 Open a New UI in the GUIDE Layout Editor
    4.3.2 Set the Window Size in GUIDE
    4.3.3 Layout the Simple GUIDE UI
    4.3.4 Align the Components
    4.3.5 Label the Push Buttons
    4.3.6 List Pop-Up Menu Items
    4.3.7 Save the UI Layout
5.3.8 Code Push Button Behaviours
    4.3.9 Open and Run the Simple GUIDE UI
4.4 Result Analysis
    4.4.1 Main Window
    4.4.2 Linear Properties
    4.4.3 Dispersion
    4.4.4 Pulse broadening factor
4.5.1 Gaussian Pulse
4.5.2 Chirped Gaussian Pulse
4.6.1 Nonlinear Phase Shift
4.6.2 SPM frequency chirp
4.7.1 Input window for non linearity
4.7.2 Nonlinearity (Phase change VS distance travelled)
4.7.3 Nonlinearity (Phase broadening factor vs Number of steps)
4.7.4 Nonlinearity
4.7.5 Nonlinearity (increased Input power 0.64 Watts)
4.7.6 Fundamental Solitons
4.8 Summary

Chapter 5
Conclusion and Future Works
5.1 Conclusion
5.2 Future works
Bibliography
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fig 2.1</td>
<td>Fiber Communication System</td>
<td>06</td>
</tr>
<tr>
<td>Fig 2.2</td>
<td>A Typical signal mode fiber</td>
<td>07</td>
</tr>
<tr>
<td>Fig 2.3</td>
<td>Refractive index distribution of a step-index optical fiber</td>
<td>08</td>
</tr>
<tr>
<td>Fig 2.4</td>
<td>Illustration of acceptance angle related to numerical aperture NA</td>
<td>09</td>
</tr>
<tr>
<td>Fig 2.5</td>
<td>Measured loss spectrum</td>
<td>11</td>
</tr>
<tr>
<td>Fig 2.6</td>
<td>Instantaneous frequency of an initially unchirped pulse</td>
<td>15</td>
</tr>
<tr>
<td>Fig 3.1</td>
<td>Negative chirp and positive chirp</td>
<td>26</td>
</tr>
<tr>
<td>Fig 3.2</td>
<td>dispersed pulse</td>
<td>26</td>
</tr>
<tr>
<td>Fig 3.3</td>
<td>Pulse broadening with same spectrum</td>
<td>27</td>
</tr>
<tr>
<td>Fig 3.4</td>
<td>dispersion-induced broadening for Gaussian pulses</td>
<td>30</td>
</tr>
<tr>
<td>Fig 3.5</td>
<td>super-Gaussian pulses the frequency chirp</td>
<td>32</td>
</tr>
<tr>
<td>Fig 3.6</td>
<td>Dispersive effect on Gaussian pulse broadening</td>
<td>33</td>
</tr>
<tr>
<td>Fig 3.7</td>
<td>Simulation of SPM on spectral broadening</td>
<td>34</td>
</tr>
<tr>
<td>Fig 4.1</td>
<td>Main Window</td>
<td>45</td>
</tr>
<tr>
<td>Fig 4.2</td>
<td>linear Properties</td>
<td>46</td>
</tr>
<tr>
<td>Fig 4.3</td>
<td>Dispersion</td>
<td>47</td>
</tr>
<tr>
<td>Fig 4.4</td>
<td>Pulse broadening factor</td>
<td>48</td>
</tr>
<tr>
<td>Fig 4.5</td>
<td>Gaussian Pulse</td>
<td>49</td>
</tr>
<tr>
<td>Fig 4.6</td>
<td>Chirped Gaussian Pulses</td>
<td>50</td>
</tr>
<tr>
<td>Fig 4.7</td>
<td>Nonlinear Phase Shift</td>
<td>51</td>
</tr>
<tr>
<td>Fig 4.8</td>
<td>SPM frequency chirp</td>
<td>52</td>
</tr>
<tr>
<td>Fig 4.9</td>
<td>Input window</td>
<td>53</td>
</tr>
<tr>
<td>Fig 4.10</td>
<td>Nonlinearity (Phase change VS distance travelled)</td>
<td>54</td>
</tr>
<tr>
<td>Fig 4.11</td>
<td>Nonlinearity (Phase broadening factor vs Number of steps)</td>
<td>55</td>
</tr>
<tr>
<td>Fig 4.12</td>
<td>Nonlinearity</td>
<td>56</td>
</tr>
<tr>
<td>Fig 4.13</td>
<td>Nonlinearity (increased Input power 0.64 Watts)</td>
<td>57</td>
</tr>
<tr>
<td>Fig 4.14</td>
<td>Fundamental Solitons</td>
<td>58</td>
</tr>
</tbody>
</table>
Symbols

\( \alpha \rightarrow \) Alpha, Attenuation
\( \beta \rightarrow \) Beta, Dispersion
\( \gamma \rightarrow \) Gama, Non Linearity
\( \lambda \rightarrow \) Lamda, Wavelength
\( \omega \rightarrow \) Frequency
\( \pi \rightarrow \) Pi
\( n_1 \rightarrow \) Refractive index
\( n_2 \rightarrow \) Non linear refractive index
\( I \rightarrow \) Optical Intensity
\( NA \), Numerical aperture
\( L \), fiber with length
\( A_{eff} \), is the effective mode area
\( P_{th} \), Threshold power
\( \omega_j \) is the resonance frequency
\( B_j \) is the strength of jth resonance.
\( \omega_0 \), central frequency
\( \phi_{NL} \rightarrow \) Non linear phase
\( \phi_D \rightarrow \) Dispersion phase
The satisfaction that accompanies the successful completion of any task would be incomplete without the mention of people whose ceaseless cooperation made it possible, whose constant guidance and encouragement crown all efforts with success.

First of all I must thank the Almighty upon who rests the supreme authority. Without His mercy it is impossible to have any success.

I would like to express my heartfelt gratitude to Dr. Md. Saiful Islam, Professor, IICT, BUET for the guidance, inspiration and constructive suggestion which helped me to complete my project work successfully.

Muhammad Hasibul Hossain
Abstract

Light wave communication systems using fibers as the communication medium, for transmission network started at 1980. Because of the low-loss and wide bandwidth transmission characteristics of optical fibers, they are ideally suited for carrying voice, data and video signals in a high-information-capacity system. Education in optical communication systems must include an understanding of the basic building blocks of optical devices and their properties as well as interplay between them. Physical scales ranges from nanometer device features to thousands of kilometers of optical fiber links. To meet the growing demand of huge bandwidth, optical communication systems continue to evolve at a rapid pace and the focus of industry research has shifted from long haul to metro to the home networks. The signal quality depends on many parameters and device characteristics of light sources, modulators, optical fiber, photo-detectors and receiver electronics. The function of signal propagation phenomena through the fiber is quite subtle to understand. Due to absence optical communication lab or proper hardware, it is often difficult to demonstrate realistic optical signal propagation through the fiber. For a student studying optical system design becomes easy by overcoming the various impairments and maintaining a minimum signal quality through educational simulation system. In this project, an attempt has been made to develop a photonic software system to demonstrate the various properties of optical fiber and mechanism of signal propagation through it. This software system can be a valuable aid in the education of optical communication systems. It will provide a convenient method to move past the abstract level of theory to gain insight into physical phenomenon associated with optical transmission systems. It certainly provides more freedom to explore design parameters than analytic calculation and physical experiments. This also allows students to develop an intuitive understanding of optics in a rapid way. It is expected that the computer simulation will enhance our fiber optic courses significantly by adding a reasonably realistic and accessible test bed for designs.
Chapter 1

Introduction

1.1 Introduction

Optical fiber is a medium for carrying information from one point to another in the form of light. A basic fiber optic system consists of a transmitting device, which generates the light signal; an optical fiber cable, which carries the light; and a receiver, which accepts the light signal transmitted [1]. The fiber itself is passive and does not contain any active and generative properties.

Since its invention in the early 1970s, the use and demand of optical fiber has grown tremendously [2]. The uses of optical fiber today are quite numerous. The most common uses are in telecommunications, medicine, military, automotive, and industrial. Telecommunications applications are widespread, ranging from global networks to local telephone exchanges to subscribers' homes to desktop computers. These involve the transmission of voice, data, or video over distances of less than a meter to hundreds of kilometers, using one of a few standard fiber designs in one of several cable designs.

The huge bandwidth of fiber makes it the perfect choice for transmitting signals to subscribers. Once upon a time, the world assumed that fiber possessed infinite bandwidth and would meet mankind’s communication needs into the foreseeable future. But in reality fiber has some impairment and that inhibits to transmit huge information. As the need arose to send information over longer and longer distances, the fiber optic community developed additional wavelength “windows” that allowed longer transmission with higher bit rate. For example, the third window 1550 nm region, with a loss of only 0.2 dB/km whereas the loss at first window 850 nm and second window 1300 nm are 1.2 dB/km and 0.4 dB/km respectively[3].

Millions of kilometers of fiber have been installed around the globe creating a high-speed communication network. Still to support the demand of higher bandwidth- wavelength division multiplexing (WDM) system is introduced. WDM is the process of multiplying the available capacity of optical
fibers through use of parallel channels, each channel on a dedicated wavelength of light. This requires a wavelength division multiplexer in the transmitting equipment and a demultiplexer in the receiving equipment. Using WDM technology now commercially available, the bandwidth of a fiber can be divided into as many as 160 channels to support a combined bit rate in the range of 1.6 Tbit/s [4].

1.2 Fiber Impairments and Importance of Simulation

The optical fiber is often seen as a perfect transmission medium with almost limitless bandwidth, but in practice the propagation through optical fiber is beset with several limitations especially as distance is increased to multi-span amplified systems. As the transmission systems evolved to longer distances and higher bit rates, the linear effect of fibers, which is the attenuation and dispersion, becomes the important limiting factor. Linear effects are wavelength dependent and nonlinear effects like Kerr effects and stimulated scattering are intensity dependent [4].

Simulation is getting information about how something will behave without actually testing it in real life. The use of simulation within engineering is well recognized. Simulation has already helped to reduce costs, increase the quality of products and systems, and document and archive lessons learned. Evaluating and visualizing the various properties and performance of optical transmission system using only analytical techniques is very difficult. Simulation optical communication software programs are essential tools to predict how optical systems work as well as to understand the linear and nonlinear properties of pulse propagation through single mode fiber in a cost effective way. Simulation techniques become popular in academia because common students are visually oriented and some concepts are simply easier to understand through simulation. Education in optical communication system must include an understanding of the basic building block of optical transmission system
and computer simulation can enable a student to jump over the hurdle that an abstract physical concepts presents. There are many simulation tools of photonic simulation software are commercially available in the market but most of those are copy righted and costly. An attempt has been made to develop simulation programs for the transmission of optical pulse considering the linear and nonlinear effects of fiber which can be used to enhance education of optical transmission system.

1.3 Objectives with Specific Aims

This project aims to investigate the various linear and nonlinear effects on pulse propagation in SMF through simulation. The specific objectives are:

a. To simulate the linear effects like attenuation, dispersion, etc, this causes the majority losses of optical transmission signal.

b. To simulate the Kerr nonlinearities when the transmission power is appreciably high or multiple channels of pulses propagate through the same fiber.

c. To simulate the combined effects of both linear and nonlinear phenomena and evaluation of the transmission performance.

1.4 Possible Outcome

The developed simulation software may be used by the students to enhance the concept and visualize the effect of linear and nonlinear phenomena of optical fiber as well as to predict the effects of optical components along a fiber transmission link. In addition to imitating fiber properties to see how they behave under different conditions, it will help to design new system within a short time. After creating a theory of causal relationships, it will help students to verify various relationships and if the system behaves in the same way as the real process, then students will be able to grasp the concepts easily.

1.5 Methodology
Simulation to other communication systems, the overall behaviour of an optical transmission system can be visualized employing the particular responses of each one of the subsystems that it comprises. In optical communication, there are three different parts: optical transmitter, communication channel made of optical fiber and the optical receiver. In this project, we have studied and simulated the linear and nonlinear properties of communication channel hence single mode fiber (SMF). Linear effects are dispersion and attenuation. On the other hand, Kerr nonlinearities describe change in refractive index of fiber due to electrical perturbations and results performance degradation at high optical power [5]. Simulation processes helps to grasp the concepts easily, simplifies the design of optical transmission system and makes the design process more efficient, less expensive, and faster. The following steps are followed to implement the project:

a. Analytical and empirical model of various linear properties of SMF are studied and identified.
b. Nonlinear Schrödinger equation (NLSE) is analyzed for studying behavior of pulse propagation through SMF.
c. NLSE is solved numerically using split-step Fourier method for different link length as well as input power [6]. At lower optical power, only the linear effects are observed and high power the nonlinear effects is usually dominant.
d. MATLAB software is used to simulate of both the linear and nonlinear effects of SMF [6]. It provides a comprehensive graphical environment, which includes color, surface plots in three dimensions, etc., that enables to create relevant animations and thus provide greater insight into the underlying physical processes.

1.6 Outline of this report

The primary intention of the project is to simulate the various linear and nonlinear properties of optical fiber and the report is presented in a manner that it will comprehensible to any reader who has some knowledge of fiber optic based technology. Therefore a through introduction of the fiber properties is given in Chapter 2 When signal transmitted through the fiber, it encounters
various impairments and all the impairments are divided into two classes- Linear and nonlinear. Attenuation and dispersion of optical signal are described.

Then in Chapter 3, Non linear Schrodinger equation, Soliton, GVD Effect on Gaussian Pulse, Limitation of Dispersion and Nonlinearity are also described. Simulation Environment and Simulation of Optical fiber Properties are in chapter 4 and Conclusion and Future Works are in chapter 5.

1.7 Summary

At the beginning of this chapter, a brief introduction of the fiber-optic communication and importance of simulation is outlined. Then the objectives as well as the methodology are pointed out. The project aims to investigate the various linear and nonlinear effects on pulse propagation in SMF through simulation.
Chapter 2

Fiber properties and Pulse Propagation

2.1 Introduction

A basic fiber communication system primarily consists of the following components: a transmitting device, which generates the light signal; an optical fiber, which carries the light beam loaded with information; a number of repeaters, which boost the signal strength to overcome the fiber losses; and a receiver, which accepts the light signal transmitted. These components shown in Fig 2.1

![Typical fiber optical fiber communication system](image)

Fig. 2.1 Typical fiber optical fiber communication system, which consist of an optical transmitter (laser diode or LED), the transmission medium (optical fibers), a repeater and an optical receiver (photodetector). The light is launched through the link.

The optical fibers as transmission media have developed and improved rapidly over the last few years. Compared with traditional communication system, optical fibers possess the following advantages:

- **Wide transmission bandwidth.** The principal material in fiber fabrication is fused silica, whose optical carrier wavelengths are between 0.8 \( \mu m \) and 1.65 \( \mu m \). This property makes a fiber possible to support a wide transmission bandwidth (0.1-1000 GHz)[7]. With such a large potential of its capacity, optical fiber becomes irreplaceable in the field of communication system.

- **Long distance signal transmission.** The low attenuation and superior signal integrity found in optical systems allow much longer intervals of signal transmission than electronic systems. With the development of the
fiber fabrication, the loss of the glass fibers nowadays have been reduced to 0.15 dB/km in the telecom window around 1.55 μm.

- **Impervious to electromagnetic interference.** The fiber communication system is hardly influenced by external electric or magnetic fields, and immune to radiation outside of the fibers, which prevents the system from corruption of data and avoids producing electromagnetic pollution.

### 2.2 Classification of optical fibers

Generally, an optical fiber is made of a central dielectric core of a high refractive index, a cladding with a lower refractive index, a buffer and a jacket. The common structure of a fiber is shown in Fig. 2.2

![Fig. 2.2: a typical single mode fiber, which consist of core, cladding, buffer and jacket.](image)

Based on the supported mode, optical fibers are classified into two types: single-mode fiber (SMF) and multimode fiber (MMF). A SMF can support only the lowest order propagating mode (fundamental mode) at the wavelength of interest. It is used to guide light for long-distance telephony and multichannel television broadcast systems[8]. The refractive index profiled of a SMF is usually a step-index type. Multimode fiber, through which numerous modes or light rays simultaneously propagate, is used to guide light for short transmission distances, such as in LAN systems and video surveillance.

To specifically describe optical fibers, some parameters, which affect the communication system’s operation, are designed as follows:
(i) $n_1$ and $n_2$ are the refractive indices of the core and cladding (see figure 2.3). The refractive-index difference between the core and the cladding $\Delta$, which is realized by the different use of dopants, such as $\text{GeO}_2$ and $\text{P}_2\text{O}_5$, can be defined as:

$$\Delta = \frac{n_1 - n_2}{n_1} \quad \text{(2.1)}$$

![Refractive index distribution of a step-index optical fiber](image)

Fig. 2.3 Refractive index distribution of a step-index optical fiber

(ii) $V$, the so called normalized frequency, is the parameter to determine the number of modes supported by the fiber, defined as

$$V = \frac{2\pi}{\lambda} \sqrt{n_1^2 - n_2^2} \quad \text{................................(2.2)}$$

Where $r$ is the radius of the core, $\lambda$ is the free-space wavelength of the light source. For a step-index fiber, only the lowest order mode (fundamental mode) propagates in the fiber if $V$ is smaller than 2.405. Optical fibers designed to satisfy this condition are called single-mode fibers.

(iii) Numerical aperture $NA$, which is a measure of the light gathering power of
the optical fiber, can be defined by the following equation [9]:

\[ NA = \sqrt{n_1^2 - n_2^2} \] ..............................(2.3)

It can be considered as representing the size or "degree of openness" of the input acceptance cone, the half angle of which is \( \theta \), as shown in Figure 2.4. If \( \sin \theta \) is smaller than the numerical aperture \( NA \), the incident light will be guided through the fiber. The value of numerical aperture lies between 0 and 1. With a numerical aperture of 0, the fiber gathers no light and with a numerical aperture of 1, the fiber gathers all the light that falls onto it.

![Fig. 2.4 Illustration of acceptance angle related to numerical aperture NA](image)

### 2.3 Material and doping

The materials, which are used to make optical fibers, should be transparent to optical frequencies and inexpensive in fiber fabrication. And in the case of long-range communication they should make possible repeater separation distances on the order of kilometers. Pure silica glass synthesized by fusing \( \text{SiO}_2 \) molecules is found to satisfy the requirements above. Besides those advantages, fused silica is of negligible thermal expansion, excellent thermal shock resistance and good chemical inertness, which make it easier to work with.

The refractive index difference between the core and the cladding is realized by doping the core material with dopants such as \( \text{GeO}_2 \) and \( \text{P}_2\text{O}_5 \), the refractive indices of which are larger than that of pure silica, and doping the cladding with materials such as boron and fluorine, which decreases the refractive index of pure silica[9]. The amount of dopants added to the fiber must be taken into account in the designation of an optical fiber for different purposes. More dopants in the core of fiber result in higher refractive index difference
and stronger compositional fluctuations. For example, for the purpose to design a long-haul transmission fiber, the higher refractive index difference, which increases the numbers of guiding modes along the fiber, leads to higher group delay and reduces output intensity, and the stronger compositional fluctuations increase the fiber loss through the dopants scattering.

2.4 Fiber impairments

Even though the raw material for making optical fibers, sand, is abundant and it carries higher amount of information with respect to copper cable, still it has some impairments which restrict the amount of information transmission. When signal transmitted through the fiber, it encounters various impairments and all the impairments are divided into two classes—Linear and nonlinear. Again linear and nonlinear has subdivision as well. These are:

a) Linear impairments:
   i. Attenuation
   ii. Dispersion
      a. Chromatic dispersion
      b. Mode dispersion
      c. Polarization mode dispersion

b) Nonlinear impairments:
   i. Kerr effect
      a. Self Phase Modulation
      b. Cross Phase Modulation
      c. Four wave Mixing
   ii. Stimulated Scattering
      a. Stimulated Brillion scattering (SBS)
      b. Stimulated Raman scattering (SRS)

The following sections, describes the above effects in brief:

2.5 Attenuation

Attenuation represents the reduction of signal strength during transmission and mathematically it is given by
\[ \alpha = \frac{10}{L} \log \left( \frac{P_1}{P_0} \right) \]  

in units of dB/km (decibel units), where \( P_0 \) is the power launched at the input end of a fiber with length \( L \) and \( P_1 \) is the transmitted power. Now a day’s fused silica fibers have losses of less than 0.15 dB/km at 1.55 \( \mu \)m, corresponding to more than 97% transmission over 1 km. The mechanisms responsible for the attenuation are the material absorption and Raleigh scattering dominantly[10]. When it is necessary for an optical fiber to guide light over long distances, a series of repeaters are used to overcome attenuation. The repeaters, which are inserted along the length of fiber, boost the pulse intensity to reconstruct it to its original quality.

2.6 Fiber attenuation mechanisms

The mechanisms which contribute to the loss in an optical fiber can be categorized as intrinsic, extrinsic and, radiative losses.

![Measured loss spectrum (black solid) of a single mode silica fiber. The blue dashed curve shows the contribution resulting from Rayleigh scattering, and the red solid curve illustrate the loss profile arising from infrared absorption](image)

Intrinsic losses can be further subdivided into infrared absorption and Rayleigh scattering in the wavelength regions of interest to optical communication.
Infrared absorption arises from the interaction of the light with the components of the glasses used in fiber manufacture. For silica fiber, the lattice vibration modes of silicon-oxygen bonds produce absorptive resonances between 7 and 11 \( \mu \text{m} \), which, due to the anharmonic coupling between those modes, further generate an infrared absorption tail extending into the transmission wavelength region. Rayleigh scattering arises from the composition and density fluctuations of the fiber material during manufacture. The resulting inhomogeneous refractive index scatters light in all directions. The loss due to Rayleigh scattering is proportional to \( 1/\lambda^4 \), where \( \lambda \) is the wavelength of the propagating light wave. The addition of dopants into the fiber results in higher inhomogeneities in the refractive index distribution, which increases the Rayleigh scattering loss. Figure 2.5 shows the measured loss spectrum of a single-mode silica fiber. Fiber losses increase rapidly as wavelength decreases and reach a level of a few dB/km in the visible region, which is caused by the Rayleigh scattering.

The absorption at wavelengths longer than 1.6 \( \mu \text{m} \) comes from infrared absorption by silicon-oxygen bonds in the glass; as the plot shows, the absorption increases sharply with longer wavelengths in the near infrared. As a result, silica-based fibers are rarely used for communications at wavelengths longer than 1.65 \( \mu \text{m} \). The rapid decrease in scattering at longer wavelengths makes minimum value of loss about 0.2 dB/km near 1.55 \( \mu \text{m} \), where both Rayleigh scattering and infrared absorption are low.

Extrinsic absorption arises generally from the presence of transition metal ions impurities and OH ions dissolved in glass. All of them have strong absorption in the visible and near infrared region, therefore, their concentration should be reduced to a low level so that they contribute negligibly to the fiber loss.

Radioactive losses, relative to the waveguide structure, arise fundamentally from geometrical irregularities, bending losses, micro bending losses, and defects at joints between fibers, which couple the guided modes with the radiation modes propagating in the cladding. The geometrical irregularities introduced in fiber manufacture include core-cladding interface irregularities, diameter
fluctuations and so forth. Bending loss occurs if the fiber is not absolutely straight. Micro bending losses are induced in the process of jacketing, where the fiber is subjected to microscopic deviations of the fiber axis from the straight condition. Defects at joints arise from the mismatch of the mode field intensity distribution when coupling light into a fiber. With careful design and fabrication, all of the radiative losses can be reduced to small value.

2.7 Dispersion

Dispersion represents a broad class of phenomena related to the fact that the velocity of the electromagnetic wave depends on the wavelength. In telecommunication the term of dispersion is used to describe the processes which cause that the signal carried by the electromagnetic wave and propagating in an optical fiber is degraded as a result of the dispersion phenomena. This degradation occurs because the different components of radiation having different frequencies propagate with different velocities. We distinguish various kinds of dispersion: Chromatic dispersion- i) Waveguide dispersion (optical) and ii) Material dispersion.

In an ideal optical fiber, the core has a perfectly circular cross-section. In this case, the fundamental mode has two orthogonal polarizations (orientations of the electric field) that travel at the same speed. The signal that is transmitted over the fiber is randomly polarized, i.e. a random superposition of these two polarizations, but that would not matter in an ideal fiber because the two polarizations would propagate identically (are degenerate).

In a realistic fiber, however, there are random imperfections that break the circular symmetry, causing the two polarizations to propagate with different speeds. In this case, the two polarization components of a signal will slowly separate, e.g. causing pulses to spread and overlap[11-12]. Because the imperfections are random, the pulse spreading effects correspond to a random walk, and thus have a mean polarization-dependent time-differential $\Delta \tau$ (also
called the differential group delay or DGD) proportional to the square root of propagation distance $L$:

$$\Delta T = D_{\text{PMD}} \sqrt{L}$$

(2.5)

$D_{\text{PMD}}$ is the PMD parameter of the fiber, typically measured in $\text{ps}/\sqrt{\text{km}}$, a measure of the strength and frequency of the imperfections.

The symmetry-breaking random imperfections fall into several categories. First, there is geometric asymmetry, e.g. slightly elliptical cores. Second, there are stress-induced material birefringence, in which the refractive index itself depends on the polarization. Both of these effects can stem from either imperfection in manufacturing (which is never perfect or stress-free) or from thermal and mechanical stresses imposed on the fiber in the field — moreover, the latter stresses generally vary over time.

### 2.8 Kerr effect

The Kerr effect is a nonlinear optical effect occurring when intense light propagates in crystals and glasses, but also in other media such as gases. Its physical origin is a nonlinear polarization generated in the medium, which itself modifies the propagation properties of the light. The Kerr effect is the effect of an instantaneously occurring nonlinear response, which can be described as modifying the refractive index. In particular, the refractive index for the high intensity light beam itself is modified according to

$$\Delta n = n_2 I$$

(2.6)

With the nonlinear index $n_2$ and the optical intensity $I$. The $n_2$ value of a medium can be measured.

### 2.9 Self Phase Modulation

One of the consequences of the Kerr effect is self-phase modulation (SPM). This means that a light wave in the fiber experiences a nonlinear phase delay which results from its own intensity.

For a fiber mode, the phase change per unit optical power and unit length is described by the proportionality constant called nonlinear coefficient [11]
\[ \gamma_{\text{SPM}} = \frac{2\pi b}{A_{\text{eff}}} \]  

(in units of rad/(W \cdot m)) where \( A_{\text{eff}} \) is the effective mode area. Interestingly, for a nearly Gaussian mode shape with beam radius \( w \) this value is only half the value for a Gaussian beam in a homogeneous medium, where only the on-axis value is considered.

If an optical pulse is transmitted through a fiber, the Kerr effect causes a time-dependent phase shift according to the time-dependent pulse intensity. In this way, an initial unchirped optical pulse acquires a so-called chirp, i.e., a temporally varying instantaneous frequency. This is shown in Figure 2.6:

**Fig 2.6:** Instantaneous frequency of an initially unchirped pulse which has experienced self-phase modulation. The central part of the pulse exhibits an up-chirp.

### 2.10 Cross Phase Modulation

It is a nonlinear optical effect where one wavelength of light can affect the phase of another wavelength of light through the optical Kerr effect. Optical cross phase modulation (XPM) is as a non-linear optical process where the wavelength of one light source affects the phase of another wave [12]. Optical cross phase modulation is brought about by the optical Kerr effect - a non-linear optical phenomenon in which the refractive indices of non-linear materials change when an ultra short pulse propagates through them. The pulse phase is modulated spatially and time wise. Self-modulation and self focusing of the wave is done by the pulse...
itself. Cross-phase modulation occurs due to the phase modulations that are generated by the co-propagating waves.

2.11 Four wave Mixing

Four waves mixing (FWM) is caused by non linear nature of the refractive index of the optical fiber itself, and is classified as third order distortion phenomenon. In multichannel systems, third order mechanisms generate third order harmonics and gamut of cross products. These cross products cause the most problems since they can fall near or on top of the desired signals. FWM is the major source of nonlinear cross-talk for WDM communication systems. It can be understood from the fact that beating between two signals generates harmonics at difference frequencies. If the channels are equally spaced new frequencies coincide with the existing channel frequencies. This may lead to nonlinear cross-talk between channels. When the channels are not equally spaced, most FWM components fall in between the channels and add to overall noise.

Here, we consider a simple three-wavelength (λ1, λ2 and λ3) that are experiencing FWM distortion. In this simple system, nine cross products are generated near λ1, λ2 and λ3 that involve two or more of the original wavelengths. Note that these are additional products generated, but they fall well away from the original input wavelengths.

Two factors strongly influence the magnitude of FWM products, referred to as (the mixing efficiency), expressed in dB.

1. Channel spacing, mixing efficiency increases with channel spacing becomes closer.
2. Fiber dispersion, mixing efficiency is inversely proportional to fiber dispersion, being strongest at zero-dispersion point.

2.12 Stimulated Scattering

Signal photon scatters off oscillation that is present in the material, gains or losses frequency equivalent to that of the material oscillation. At high powers, beating of signal frequency and scattered frequency generates frequency component at the difference that drives the material oscillations. Stimulated
scattering is characterized by 3-major parameters:

(i) Threshold power, $P_{th}$
(ii) Gain, $g$
(iii) Range of frequencies ($\delta \lambda$) within which scattering is effective.

$P_{th}$ is the power of incident light at which the loss due to stimulated scattering is 3 dB— that is, half— over the fiber length L.

Stimulated scattering is transferring energy from the incident wave to another, scattered wave a lower frequency (longer wavelength) with the small energy difference being released in the form of phonons. A phonon is an elementary particle analogous to a photon but differs from a photon in its quantum properties. The incident wave can be seen as a kind of pump wave. Scattered waves are called Stoke’s wave.

2.13 Stimulated Brillion Scattering (SBS)

SBS occurs in optical fiber due to a relatively complex interaction between the launched optical signal (a pump wave) and an acoustic wave (created by the optical signal). The interaction of these two waves results in the generation of a backward-propagating optical wave (toward the launch origin). The pump wave (traveling at the speed of light - approximately 200,000 km/sec in glass) generates acoustic waves (travelling at the speed of sound - < 5 km/sec in glass) in the transmission medium through a process called “electrostriction.” As the sound waves travel through the solid, transparent glass material, they induce spatially periodic local compressions and expansions which in turn cause local increases and decreases in the refractive index. This effect is termed the “photo-elastic effect.” The magnitude of the photo-elastic effect increases with increasing input optical power. When the input power reaches a level referred to as the “SBS Threshold”, the refractive index of the fiber has been acoustically altered to a degree such that a significant portion of the optical signal is back-scattered[13-14]. As the transmitted power level is increased beyond the SBS threshold, an increasingly large portion of the light is back-scattered, creating an upper limit to the power levels that can be effectively transported over the fiber.
When photons are scattered from an atom or molecule, most photons are elastically scattered (Rayleigh scattering), such that the scattered photons have the same energy (frequency and wavelength) as the incident photons. A small fraction of the scattered photons (approximately 1 in 10 million) are scattered by an excitation, with the scattered photons having a frequency different from, and usually lower than that of the incident photons.

2.14 Stimulated Raman Scattering (SRS)

When light propagates through a medium, the photons interact with silica molecules during propagation. The photons also interact with themselves and cause scattering effects, such as stimulated Raman scattering (SRS), in the forward and reverse directions of propagation along the fiber. This results in a sporadic distribution of energy in a random direction.

SRS refers to lower wavelengths pumping up the amplitude of higher wavelengths, which results in the higher wavelengths suppressing signals from the lower wavelengths. One way to mitigate the effects of SRS is to lower the input power. In SRS, a low-wavelength wave called Stoke's wave is generated due to the scattering of energy. This wave amplifies the higher wavelengths. The gain obtained by using such a wave forms the basis of Raman amplification. The Raman gain can extend most of the operating band (C- and L-band) for WDM networks. SRS is pronounced at high bit rates and high power levels. The margin design requirement to account for SRS/SBS is 0.5 dB.

2.15 Pulse propagation through the fiber

The attenuation, dispersion is called linear properties on the optic fiber. Pulse propagation within a dispersion and nonlinear media like fiber can be represent by non-linear Schrödinger equation. The nonlinear Schrödinger equation is
\[
\frac{\partial A}{\partial z} - j\frac{\beta_2}{2} \frac{\partial^2 A}{\partial z^2} + \frac{\alpha_2}{2} A = -j|A|^2 A \tag{2.8}
\]

\[\text{Dispersion Part} \quad \text{Non-linearity Part}\]

\[
\gamma = \frac{n_2 \alpha_0}{c A_{\text{eff}}} = 1-100 \text{ W}^3/\text{km}, \quad A_{\text{eff}} = \frac{\int \int |F(x,y)|^2 \, dx \, dy}{\int \int |F(x,y)|^4 \, dx \, dy} = 1-100 \mu \text{m}^2
\]

Assuming \(\beta_2\) is negligible and no non-linearity i.e. \(\gamma = 0\)

\[
\frac{\partial A}{\partial z} = -\frac{\alpha_2}{2} A \tag{2.9}
\]

Solution of this equation is \(A(z) = A(0) e^{-\frac{\alpha_2}{2} z}\)

Since \(\alpha\) is constant, signals propagates in the fiber which is exponential decay of the signal.

### 2.16 Summary

The optical fiber itself is a passive element and it carries light power through its core supports large bandwidth. When light propagates through it undergoes through lots of obstacles which intimately limits its bandwidth. In this chapter fiber classification and its various properties are discussed in brief. Finally NLSE is introduced to give an idea how really signal propagates through the fiber.
Chapter 3
Mechanism of Dispersion and Nonlinearity

3.1 Introduction

It has been mentioned that dispersion represents a broad class of phenomena related to the fact that the velocity of the electromagnetic wave depends on the wavelength. In telecommunication the term of dispersion is used to describe the processes which cause that the signal carried by the electromagnetic wave and propagating in an optical fiber is degraded as a result of the dispersion phenomena. This degradation occurs because the different components of radiation having different frequencies propagate with different velocities [14].

The fiber loss depends on the wavelength of the light. The fiber exhibits a minimum loss of about 0.2dB/Km near 1.55μm. The loss is considerable higher at shorter wavelengths. Material absorption and Rayleigh scattering contribute dominantly to the loss spectrum.

3.2 Dispersion in Single-Mode Fibers

In multimode fibers, intermodal dispersion leads to considerable broadening of short optical pulses (~10ns/Km). The main advantage of single mode fibers is that intermodal dispersion is absent simply because the energy of the injected pulse is transported by a single mode. But the group velocity associated with the fundamental mode is frequency dependent because of the chromatic dispersion. As a result, different spectral components of the pulse travel at slightly different group velocities, a phenomenon referred to as group-velocity dispersion (GVD), intermodal dispersion, or simply fiber dispersion, Intermodal dispersion has two contributions known as material dispersion and waveguide dispersion.

3.3 Group Velocity Dispersion (GVD)

A modulated optical signal contains frequency components that travel (in the fiber) with slightly different phase velocities. When an electromagnetic wave interacts with bound electrons of a dielectric, the medium response in general
depends on the optical frequency $\omega$. This property, referred to as chromatic dispersion, manifests through the frequency dependence of the refractive index $n(\omega)$. On a fundamental level, the origin of chromatic dispersion is related to the characteristic resonance frequencies at which the medium absorbs the electromagnetic radiation through oscillation of bound electrons. Far from the medium resonances, the refractive index is well approximated by the Sellmeier equation,

$$n^2(\omega)=1+\sum_{j=1} B_j \omega_j^2$$ ...........................................(3.1)

Where $\omega_j$ is the resonance frequency and $B_j$ is the strength of $j$th resonance.

GVD plays a critical role in propagation of short optical pulses since different spectral components associated with the pulse travel at different speeds given by $c/n(\omega)$ [15][16]. Mathematically, the effect of fiber dispersion is accounted for by expanding the mode-propagation constant $\beta$ in a Taylor series about the center frequency $\omega_0$.

$$\beta(\omega)=n(\omega)\frac{\omega}{c}=\beta_0+\beta(\omega-\omega_0)+\frac{1}{2}\beta_2(\omega-\omega_0)^2+............. .........(3.2)$$

Where $\beta_m= \left[ \frac{d^m \beta}{d\omega^m} \right]_{\omega=\omega_0}$ ( $m=0, 1, 2 ...$)

The pulse envelope moves at the group velocity ($v_g=\beta_1^{1/2}$) while the parameter $\beta_2$ is responsible for pulse broadening. The parameters $\beta_1$ & $\beta_2$ are related to the refractive index $n$ and its derivatives through the relations

$$\beta_1=\frac{1}{c}[n+\omega \frac{dn}{d\omega}]=\frac{n_g}{c}=\frac{1}{v_g}$$ ...........................................(3.3)

$$\beta_2=\frac{1}{c}\left[2\frac{dn}{d\omega}+\omega \frac{d^2 n}{d\omega^2}\right]=\omega \frac{d^2 n}{c d\omega^2} \approx \frac{\lambda}{2 \pi^2} \frac{d^2 n}{d\lambda^2}$$ ...........................................(3.4)

Where $n_g$ is the group index.

The most notable feature is that $\beta_2$ vanishes at a wavelength of about 1.27μm and becomes negative for longer wavelengths. The wavelength at which $\beta_2=0$ is often referred to as zero dispersion wavelength, $\lambda_D$. However, dispersion does not vanish at $\lambda=\lambda_D$.

Pulse propagation near $\lambda=\lambda_D$ requires the
inclusion of cubic term in equation 1. Such higher order dispersive effects can distort ultra-short optical pulses both in the linear and non-linear regimes.

In Fiber optics the dispersion parameter D is defined as
\[
D = \frac{d^2 \beta}{d \lambda^2} = \frac{2 \pi}{\lambda^2} \beta_2 \approx -\frac{\lambda}{c} \frac{d^2 n}{d \Omega^2}
\] ...............................(3.5)

The non-linear effects in optical fibers can manifest a qualitatively different behaviour depending on the sign of the dispersion parameter \( \beta_2 \) or D.

Since
\[
\beta_2 = \frac{d \beta}{d \omega} = \frac{d}{d \omega} \left[ \frac{1}{v_g} \right] = -\frac{1}{v_g^2} \frac{dv_g}{d \omega}
\] ............................(3.6)

\( \beta_2 \) is generally referred to as GVD parameter.

**Normal dispersion:** For wavelengths such that \( \lambda < \lambda_D \), \( \beta_2 > 0 \) the fiber is said to exhibit normal dispersion. In normal-dispersion regime, the higher frequency (blue shifted) components of a optical pulse travel slower than the lower frequency (red shifted) components[16].

**Anomalous dispersion:** In anomalous-dispersion regime, the lower frequency (red shifted) components of an optical pulse travel slower than the higher frequency (blue shifted) components where \( \beta_2 < 0 \)

### 3.4 Material Dispersion

Material dispersion is caused by variations of refractive index of the fiber material with respect to wavelength. Since the group velocity is a function of the refractive index, the spectral components of any given signal will travel at different speeds causing deformation of the pulse[17]. Variations of refractive index with respect to wavelength are described by the Sellmeier equation which is expressed as follows
\[
r(\lambda) = \left[ 1 + \sum A_i \frac{\lambda^2}{(\lambda^2 - \lambda_i^2)} \right]^{1/2}
\] .................................(3.7)

Where \( \lambda \) is the wavelength of light, and \( A_i \) and \( \lambda_i \) are the Sellmeier coefficients.
3.5 Waveguides dispersion

Waveguides are highly dispersive due to their geometry (rather than just to their material composition). Optical fibers are a sort of waveguide for optical frequencies (light) widely used in modern telecommunications systems. The rate at which data can be transported on a single fiber is limited by pulse broadening due to chromatic dispersion among other phenomena.

In general, for a waveguide mode with an angular frequency \( \omega(\beta) \) at a propagation constant \( \beta \) (so that the electromagnetic fields in the propagation direction \( z \) oscillate proportional to \( e^{i(\beta z - \omega t)} \)), the group-velocity dispersion parameter \( D \) is defined as:

\[
D = \frac{2\pi}{\lambda} \frac{d^2 \beta}{d\omega^2} = \frac{2\pi}{\nu_g} \frac{dv_g}{d\omega} \tag{3.8}
\]

Where \( \lambda = \frac{2\pi c}{\omega} \) is the vacuum wavelength and \( \nu_g = \frac{d\omega}{d\beta} \) is the group velocity. This formula generalizes the one in the previous section for homogeneous media, and includes both waveguide dispersion and material dispersion [17-18]. The reason for defining the dispersion in this way is that \( |D| \) is the (asymptotic) temporal pulse spreading \( \Delta t \) per unit bandwidth \( \Delta \lambda \) per unit distance travelled, commonly reported in \( \text{ps} / \text{nm km} \) for optical fibers.

3.6 Nonlinear Schrodinger equation

The equation describes the propagation of an optical pulse in single-mode fibers. Fiber loss is \( \alpha \) chromatic dispersion are \( \beta_1, \beta_2, \beta_3 \) and \( \gamma \) is nonlinearity coefficient of the fiber.

From the nonlinear Schrodinger (NLS) equation that governs the propagation of optical pulses inside single mode fibers, a simplification can be made by considering pulse \( > 5 \text{ps} \)

\[
j \frac{\partial A}{\partial z} = -\frac{j \alpha}{2} A - \beta_1 \frac{\partial A}{\partial \alpha} - \frac{j}{2} \beta_2 \frac{\partial^2 A}{\partial \alpha^2} + \frac{1}{6} \beta_3 \frac{\partial^3 A}{\partial \alpha^3} + j \gamma |A|^2 A \tag{3.8}
\]

The equation describes the propagation of an optical pulse in single-mode fibers. Fiber loss is \( \alpha \) chromatic dispersion are \( \beta_1, \beta_2, \beta_3 \) and \( \gamma \) is nonlinearity coefficient of the fiber.

From the nonlinear Schrodinger (NLS) equation that governs the propagation of optical pulses inside single mode fibers, a simplification can be made by considering pulse \( > 5 \text{ps} \)

\[
j \frac{\partial A}{\partial z} = -\frac{j \alpha}{2} A + \frac{1}{2} \beta_2 \frac{\partial^2 A}{\partial \alpha^2} - \gamma |A|^2 A \tag{3.9}
\]
Where A is the slowly varying amplitude of the pulse envelope and T is measured in a frame of reference moving at the group velocity.

Depending on the initial width $T_0$ and the peak power $P_0$ of the incident pulse, either dispersive or nonlinear effects may dominate along the fiber. It is useful to introduce two length scales, known as the dispersion length $L_D$ and nonlinear length $L_{NL}$ and the fiber length $L$, the pulses can evolve differently.

Let us define two important characteristic lengths related to the dispersion and non-linearity as

\[
L_D = \frac{T_0^2}{\beta_2} = \frac{T_0^2 2\pi \gamma}{P_0} \quad \text{..................................(3.10)}
\]

\[
L_{NL} = \frac{1}{\beta_2} \quad \text{..............................(3.11)}
\]

Depending on the relative magnitude of $L$, $L_D$, $L_{NL}$, the propagation behaviour can be classified in the following categories.

**Category 1:** When the fiber length, $L$ is such that $L \ll L_D$ and $L \ll L_{NL}$, then neither dispersive nor nonlinear effects play a significant role during pulse propagation. The pulse maintains its shape during propagation. The fiber plays a passive role in this regime and acts as a mere transporter of optical pulses (except for reducing the pulse energy because of fiber loss). For ~50km, $L_D$ and $L_{NL}$ should be larger than 500km for distortion free transmission. However $L_D$ and $L_{NL}$ become smaller as pulses becomes shorter and more intense.

**Category 2:** When the fiber length is such that $L \gg L_D$ but $L \ll L_{NL}$, then the pulse propagation is governed by GVD, and the nonlinear effect play a relatively minor role. The dispersion dominant regime is applicable whenever the fiber and pulse parameters are such that

\[
\frac{L_D}{L_{NL}} = \frac{P_0 T_0^2}{\beta_2} \ll 1
\]

**Category 3:** When the fiber length is such that $L \ll L_D$ but $L \gg L_{NL}$, then the pulse evolution in the fiber is governed by SPM that leads to spectral broadening of the pulse. The nonlinearity-dominant regime is applicable whenever
\[
\frac{L_D}{L_{NL}} = \frac{\beta_0 T_0^2}{\beta_2} \gg 1
\]

**Category 4:** When the fiber length \( L \) is longer or comparable to both \( L_D \) and \( L_{NL} \), Dispersion and nonlinearity act together as the pulse propagates along the fiber. GVD, SPM and XPM play a significant role and XPM affect both the pulse shape and the spectrum.

### 3.7 Dispersive Regime

In this regime the NLSE has just the dispersion term,

\[
\frac{\partial U}{\partial z} = j \frac{\text{sgn}(\beta)}{2L_D} \frac{\partial^2 U}{\partial T^2}
\]

(3.12)

Let the input Gaussian pulse be given as,

\[
U(t, T) = e^{-T^2/2\sigma_0^2}
\]

The NSE can be solved by taking Fourier transform, to give solution,

\[
U = \frac{1}{\sqrt{1 + j \frac{\text{sgn}(\beta)}{L_D} \sigma_0^2}} \exp \left( \frac{T^2}{2\sigma_0^2 (1 + j \frac{\text{sgn}(\beta)}{L_D} \sigma_0^2)} \right)
\]

(3.13)

We can write the expression in amplitude and phase form as

\[
U(z, T) = |\mathcal{B}(z, T)| e^{j \phi(z, T)}
\]

Where,

\[
|\mathcal{B}(z, T)| = \frac{1}{\sqrt{1 + (z/L_D)^2}} e^{-\frac{T^2}{2\sigma_0^2 (1 + (z/L_D)^2)}}, \quad \phi(z, T) = \frac{\text{sgn}(\beta) (z/L_D) T^2}{1 + (z/L_D)^2 - \sigma_0^2}
\]

(3.14)
The frequency varies linearly as a function of time, $T$ [18-19]. It is then said that the pulse is linearly chirped. For positive $\beta_2$, the frequency is higher on the trailing edge of the pulse and is lower at the leading edge of the pulse as shown in Fig. The reverse happens when $\beta_2$ is negative. If $\beta_2$ is negative the dispersion is called anomalous.

Fig. 3.1: Negative chirp and positive chirp

Fig. 3.2: dispersed pulse
3.8 Pulse Broadening due to Dispersion

In dispersive regime the pulse broadens but its spectrum remains same. Only different frequencies get separated in time due to dispersion, but there are now new frequencies generated as shown in Fig. 3.3.

![Fig. 3.3: Pulse broadening with same spectrum](image)

3.9 Effective Transmission Lengths

The nonlinear effects depend on transmission length. The longer fiber link length, the more the light interaction and greater the nonlinear effect. As the optical beam propagates along the link length, its power decreases because of fiber attenuation.

The effective length \(L_{\text{eff}}\) is that length, up to which power is assumed to be constant. The optical power at a distance \(z\) along is given as, \(P(z) = P_{in} \exp(\alpha z)\) .

Where \(P_{in}\) is the input power (power at \(z=0\)) and is coefficient of attenuation.

For an actual link length \(L\), effective length is defined as, \(P_{in} L_{\text{eff}} = \int_{z=0}^{L} P(z) dz\)

So, effective length is obtained as \(L_{\text{eff}} = \frac{(1 - \exp(\alpha z))}{\alpha}\)

Since communication fibers are long enough so that \(L >> 1/\alpha\). This results in \(L_{\text{eff}} = \frac{1}{\alpha}\). This is the length which the pulse travels before power is unacceptably small.
4.10 Soliton

The important thing to note is that if dispersion is anomalous and non-linearity is present, the frequency chirps created by two effects are opposite in nature. It is possible that the two chirps cancel giving chirp-free pulse. In this case neither the pulse nor its spectrum broadens [19-20]. The undistorted pulse is called the soliton. Waves with similar features but with less dramatic effect can be created inside an optical fiber. These waves can be exploited for high speed long distance optical communication. In 1991 the optical solitons inside an optical fiber were experimentally demonstrated.

The deployment of soliton based optical communication systems still is not feasible but the technology is progressing to make the solitonic communication a reality. In the presence of non-linearity and dispersion, there is possibility of undistorted pulse propagation for infinite distance.

Let define normalized distance and normalized time as

\[
\xi = \frac{z}{L_D}, \quad \tau = \frac{T}{\tau_0}
\]

The Schrodinger equation with dispersion and non-linearity, can be written as

\[
\frac{\partial B}{\partial \xi} - j\frac{\text{sgn}(\beta_2)}{2} \frac{\partial^2 B}{\partial \tau^2} + jN^2 |B|^2 B = 0 \quad \text{.........}(3.16)
\]

Where the parameter \( N \) is defined as,

\[
N^2 = \frac{L_D}{L_N} = \frac{\gamma P_0^2}{|\beta_2|} \quad \text{.............................}(3.17)
\]

The solution to the NSE in this case is the soliton. For \( N=1 \), we get the fundamental soliton and for higher values of \( N \) we get the higher order soliton. Of course, the higher order soliton need higher optical power. The solution of the NSE for the fundamental soliton is

\[
B(\xi, \tau) = \text{sech}(\tau) e^{-j\xi/2} \quad \text{.................................}(3.18)
\]

It indicated that if a secant hyperbolic pulse is launched inside an optical fiber, it can travel undistorted for infinite distance (of course in absence of loss). The fundamental soliton has a very special wave shape, the secant hyperbolic function.
Let us see how the two frequency chirps, one due to non-linearity and other due to the dispersion get cancelled for secant hyperbolic pulse shape. The NSE due for only non-linear term is

$$\frac{\partial B}{\partial \xi} = -j N^2 |B|^2 B$$

(3.19)

The non-linear phase is,

$$\varphi_L = - |B(0, \tau)|^2 \xi = -\sec h^2(\tau) \xi$$

The NSE due only anomalous dispersion can be written as

$$\frac{\partial B}{\partial \xi} = j \frac{\text{sgn}(\beta)}{2} \frac{\partial \beta}{\partial \tau} = -j \left( \frac{1}{2B} \frac{\partial^2 B}{\partial \tau^2} \right) B$$

(3.20)

The phase due to dispersion is

$$\varphi_D = - \left( \frac{1}{2B} \frac{\partial^2 B}{\partial \tau^2} \right) \xi = - \left( \frac{1}{2\sec h^2(\tau)} \frac{\partial \sec h^2(\tau)}{\partial \tau} \right) \xi$$

The sum of the non-linear and the dispersion phase is, $$\varphi_L + \varphi_D = -\xi / 2$$ independent of time. The resultant frequency chirp therefore is zero and the pulse spectrum and consequently its shape remain unchanged.

### 3.11 GVD Effect on Gaussian Pulse

The incident field of a Gaussian Pulse is given by, 

$$U(0, T) = \exp \left[ \frac{T^2}{2T_0^2} \right]$$

(3.21)

Where $$T_0$$ is the half-width (at 1/e -intensity point). For a Gaussian pulse, the full width at half maximum (FWHM) and half-width are related by 

$$T_{FWHM} \approx 2(\ln 2)T_0 \approx 1.66T_0.$$ 

The amplitude at any point z along the fiber is given by,

$$U(z, T) = \frac{T_0}{(T_0^2 - i\beta z)^2} \exp \left[ -\frac{T^2}{2(T_0^2 - i\beta z)} \right]$$

(3.22)

Thus a Gaussian pulse maintains its shape on propagation but its width increases and becomes

$$T = T_0 \left[ 1 + (z/L_0)^2 \right]^{1/2}$$

(3.23)
Equation (2) shows that GVD broadens the pulse. The extent of broadening is governed by the dispersion length, $L_D$. For a given fiber length, short pulses broaden more because of a smaller dispersion length. At $z = L_D$, the Gaussian pulse broadens by a factor of $\sqrt{2}$.

We know GVD broadens the optical pulse as it propagates through the optical fiber. A comparison shows that although the incident pulse in the fiber is unchirped (with no phase modulation), the transmitted pulse becomes chirped. This can clearly be seen by writing the amplitude at any point $z$ along the fiber is given by $U(z,T) = U(z,T) \exp(i\Phi(z,T))$

Where $\Phi(z,T) = \frac{\text{sgn}(\beta_2)T^2}{2} + \frac{1}{2} \tan^{-1}\left[\frac{T}{L_D}\right]$ ...........................................(3.24)
The time dependence of the phase implies that the instantaneous frequency differs across the pulse from the central frequency \( \omega_0 \). The difference \( \delta \omega \) is just the time derivative \( \frac{\partial \Phi}{\partial T} \)

\[
\delta \omega = -\frac{\partial \Phi}{\partial T} = \frac{2 \text{sgn}(\beta)(z/L_D)}{1+(z/L_D)^2} \frac{T}{T_0^2}
\]

.........................................................................................(3.25)

The frequency changes linearly across the pulse. The chirp \( \delta \omega \) depends on the sign of \( \beta_2 \). In the normal dispersion, \( \delta \omega \) is negative at the leading edge \( (T<0) \) and increases linearly across the pulse; the opposite occurs in the anomalous dispersion regime. The red components travel faster than the blue components in the normal-dispersion regime \( (\beta_2 > 0) \), while the opposite occurs in the anomalous-dispersion regime \( (\beta_2 < 0) \). The pulse can maintain its width only if all the spectral components arrive together, or \( \beta_2 = 0 \). Any time delay in the arrival of different spectral components leads to spectral broadening. The dispersion-induced chirp broadens the pulse since different frequencies induced at different parts of the pulse propagate at slightly different speeds along the fiber.

### 3.12 GVD Effect on Chirped Gaussian Pulse

For an initially unchirped Gaussian pulse, the equation shows that dispersion induced broadening of the pulse does not depend on the sign of the GVD parameter \( \beta_2 \). Thus for a given value of the dispersion length \( L_D \), the pulse broadens by the same amount in the normal-dispersion and anomalous dispersion regimes of the fiber. But the behaviour of the pulse changes for Gaussian pulse. For the case of linearly chirped Gaussian pulses, the incident field is given by

\[
U(0,T) = \exp \left[ \frac{(1+iC)T^2}{2T_0^2} \right]
\]

.........................................................................................(3.26)

Where, \( C \) is the chirp parameter. Depending on the sign of \( C \), there are two kinds of chirp as follows.

**Up-chirp \( C > 0 \):** The instantaneous frequency increases linearly from the leading to the trailing edge.
**Down-chirp (C < 0):** The instantaneous frequency decreases linearly from the leading to the trailing edge.

![Figure 3.5: super-Gaussian pulses the frequency chirp](image)

3.13 Limitation of Dispersion and Nonlinearity

Group velocity dispersion (GVD) is incurred due to slightly different propagation speeds of different frequency components of pulses. The most direct effect from GVD is broadening of the pulses transmitted [20]. As a result, the pulses overlap as shown in the Fig.3.12, resulting in intersymbol interference (ISI). The impact of the dispersion can be conveniently described using the dispersion length defined as, \[ L_D = \frac{T_0^2}{\beta_2} \] .........................................................(3.27)

Where \( T_0 \) is temporal pulse width and 2 is the second-order propagation constant. This length provides a scale over which the dispersive effect becomes significant for pulse evolution along a fiber.
We primarily focus on nonlinear phase shift (NPS) originating from self-phase modulation (SPM). The result of SPM is broadening the spectrum of signals rather than temporal width as GVD does. In analogy to dispersion length, a similar concept called nonlinear length is given by, 

$$L_{NL} = \frac{1}{\gamma P_0}$$

Where nonlinearity coefficient and Po is launch power. Physically, the nonlinear length indicates the distance at which the nonlinear phase shift reaches to 1 radian. For instance, assume the nonlinearity coefficient $\gamma$ is $3 \text{ W}^{-1} \text{ km}^{-1}$, the launch power Po is 10 mW. So $L_{NL}$ is approximately 30 km, which means that over 30 km, the spectrum of signals will be broadened to a notable extent. Fig. 3.5 shows this clearly.

In analogy to dispersion length, a similar concept called nonlinear length is given by, 

$$L_{NL} = \frac{1}{\gamma P_0}$$

Where $\gamma$ nonlinearity coefficient and Po is launch power. Physically, the nonlinear length indicates the distance at which the nonlinear phase shift reaches to 1 radian. For instance, assume the nonlinearity coefficient $\gamma$ is $3 \text{ W}^{-1} \text{ km}^{-1}$, the launch power Po is 10 mW. So $L_{NL}$ is approximately 30 km, which means that over 30 km, the spectrum of signals will be broadened to a notable extent.
3.14 Summary

In this chapter, an in-depth analysis is presented on dispersion and nonlinear properties of SMF. NLSE equation is introduced which includes the linear and nonlinear properties of fiber. Assuming various boundary conditions, an analytical solution of NLSE is derived. Effects like GVD, SPM and soliton are discussed in detail.
Chapter 4
Simulation Environment and Simulation of Optical fiber Properties

4.1 Technologies Used

MATLAB is widely used in all areas of applied mathematics, in education and research at universities, and in the industry. MATLAB stands for MATrix LABoratory [21] and the software is built up around vectors and matrices. This makes the software particularly useful for linear algebra but MATLAB is also a great tool for solving algebraic and differential equations and for numerical integration. MATLAB has powerful graphic tools and can produce nice pictures in both 2D and 3D [21]. It is also a programming language, and is one of the easiest programming languages for writing mathematical programs. MATLAB also has some tool boxes useful for signal processing, image processing, optimization, etc.

4.2 How to start MATLAB

I Choose the submenu Programs from the Start menu at PC, then the Programs menu, open the "MATLAB" submenu. For quit MATLAB by typing exit in the command window.

4.3 Building the Simulation

4.3.1 At first, I did open a New UI in the GUIDE Layout Editor

1. I Started GUIDE by typing `guide` at the MATLAB prompt.

2. In the GUIDE Quick Start dialog box, I selected the Blank GUI (Default) template, and then click OK
3. I Displayed the names of the UI components in the component palette:
   
   i. Select **File > Preferences > GUIDE.**
   
   ii. Select **Show names in component palette.**
   
   iii. Click **OK.**
4.3.2 Setting the Window Size in GUIDE

I did set the size of the UI window by resizing the grid area in the Layout Editor. Clicking the lower-right corner and dragging it until the canvas is approximately 3 inches high and 4 inches wide. If necessary, make the canvas larger.

4.3.3 Laying the Simple GUIDE UI

Adding, aligning, and label the components in the UI.

1. I did add the three push buttons to the UI. Select the push button tool from the component palette at the left side of the Layout Editor and drag it into the layout area. I create three buttons, positioning them approximately as shown in the following figure.
1. Adding the remaining components to the UI.
   - A static text area
   - A pop-up menu
   - An axes

I did arrange the components as shown in the following figure. Resize the axes component to approximately 2-by-2 inches.

4.3.4 Aligning the Components

If several components have the same parent, I used the Alignment Tool to align them to one another. To align the three push buttons:
   i. Select all three push buttons by pressing Ctrl and clicking them.
   ii. Select Tools > Align Objects.
   iii. Make these settings in the Alignment Tool

To Left-aligned in the horizontal direction, I did 20 pixels spacing between push buttons in the vertical direction.
4.3.5 Labelling the Push Buttons

Each of the three push buttons specifies a plot type: surf, mesh, and contour. This topic shows how to label the buttons with those options.

i. Select View > Property Inspector.
ii. In the layout area, click the top push button.

iii. In the Property Inspector, selecting the String property, and then replace the existing value with the word Surf.

iv. Clicking outside the String field. The push button label changes to Surf.

v. Click each of the remaining push buttons in turn and repeat steps 3 and 4. Label the middle push button Mesh, and the bottom button Contour.
4.3.6 List Pop-Up Menu Items

The pop-up menu provides a choice of three data sets: peaks, membrane, and sinc. These data sets correspond to MATLAB functions of the same name. This topic shows how to list those data sets as choices in the pop-menu [21].

i. In the layout area, click the pop-up menu.

ii. In the Property Inspector, click the button next to String. The String dialog box displays.

iii. Replace the existing text with the names of the three data sets: peaks, membrane, and sinc. Press Enter to move to the next line.

iv. When I finish editing the items, click OK.

The first item in list, peaks, appears in the pop-up menu in the layout area.
4.3.7 Saving the UI Layout

After saving a layout, GUIDE creates two files, a FIG-file and a code file. The FIG-file, with extension `.fig`, is a binary file that contains a description of the layout. The code file, with extension `.m`, contains MATLAB functions that control the UI behaviour.

i. Save and run the program by selecting **Tools > Run**.

ii. GUIDE displays a dialog box displaying: "Activating will save changes to figure file and MATLAB code. If we wish to continue? Click **Yes**.

iii. GUIDE opens a **Save As** dialog box in current folder.

iv. Browse to any folder for which I have write privileges, and then enter the file name `simple_gui` for the FIG-file. GUIDE saves both the FIG-file and the code file using this name.

v. If the folder in which I save the files is not on the MATLAB path, GUIDE opens a dialog to allows you to change the current folder.

vi. GUIDE saves the files `simple_gui.fig` and `simple_gui.m`, and then runs the program. It also opens the code file in your default editor.

The UI opens in a new window. Notice that the UI lacks the standard menu bar and toolbar that MATLAB figure windows display. I added own menus and toolbar buttons with GUIDE, but by default a GUIDE UI includes none of these components [21].

When I ran `simple_gui`, I selected a data set in the pop-up menu and click the push buttons, but nothing happens. This is because the code file contains no statements to service the pop-up menu and the buttons.

5.3.8 Code Push Button Behaviours

Each of the push buttons creates a different type of plot using the data specified by the current selection in the pop-up menu. The push button callbacks get data from the `handles` structure and then plot it.

1. Display the **Surf** push button callback in the MATLAB Editor. In the Layout Editor, right-click the **Surf** push button, and then select **View Callbacks > Callback**.
In the Editor, the cursor moves to the **Surf** push button callback in the UI code file, which contains the code

```matlab
% --- Executes on button press in pushbutton1.
function pushbutton1_Callback(hObject, eventdata, handles)
  % hObject    handle to pushbutton1 (see GCBO)
  % eventdata  reserved - to be defined in a future version of MATLAB
  % handles    structure with handles and user data (see GUIDATA)
  surf(handles.current_data);
pushbutton2_Callback:
  mesh(handles.current_data);
pushbutton3_Callback:
  % Display contour plot of the currently selected data.
  contour(handles.current_data);
```

Save the code by selecting File > Save.
4.3.9 Opening and Running the Simple GUIDE UI

In Code the Behavior of the Simple GUIDE UI, I programmed the pop-up menu and the push buttons. I also created data for them to use and initialized the display. Now I ran the program to see how it worked.

i. Running the program from the Layout Editor by selecting **Tools > Run**.

![Graph](image)

ii. In the pop-up menu, I selected Membrane, and then click the Mesh button. The UI displays a mesh plot of the MathWorks.

iii. Try other combinations before closing the window.
4.4 Result Analysis

The numerical simulation results are presented in this section. It has been possible to run our simulations on a multi-core processing unit and 1 Gb RAM

4.4.1 Main Window

The main window is the first window from where we go to other window. This page contains several options like as File, Graph, Linear, Dispersion, Non Linearity and Help. This version offers a further improved user interface. Consequently, Fiber Power becomes more suitable also for those who need to get certain calculations done without spending much time on technical details.

Fig 4.1 Main window
4.4.2 Linear Properties

A user can just fill out the input fields and execute to see the output values as well as created graphical diagrams.

The graph is exponentially decayed. Power is decreased with the travelling of light. A sample is shown in fig 4.2 for input.
4.4.3 Dispersion

Different wavelengths of light moves at slightly different speeds along a fiber. When we input $s_0=0.092$, $\lambda_0=1311\text{nm}$ and $\lambda$ range (1250 nm to 1650 nm). We get the following graph. The graph describes dispersion is increased with the increase of wavelength (1250 um to 1650 um). They are very easy to use. A user can just fill out the input fields and execute to see the output values as well as created graphical diagrams.

![Dispersion Graph](image)

Fig 4.3 Dispersion
4.4.4 Pulse broadening factor

There is no change of pulse broadening factor with the fiber length up to 110 Km and then pulse broadening factor is sharply increased with fiber length (in Km range).

Fig 4.4 Pulse broadening factor
4.5.1 Gaussian Pulse

A user can just fill out the input fields and execute to see the output values as well as created graphical diagrams. The effective length of fiber is increased while the pulse is broadening.

Fig 4.5 Gaussian Pulse
4.5.2 Chirped Gaussian Pulse

A user can just fill out the input fields and execute to see the output values as well as created graphical diagrams. Broadening of the Gaussian pulse with input chirp characterized by parameter $C$ during propagation in optical fiber of positive dispersion GVD $>0$, $\ldots$ pulse at $C = 0$, $C = 2$ - pulse for input positive GVD dispersion, $C = -2$ - pulse for input negative GVD dispersion. When the optical fiber shows dispersion GVD $<0$, the same curves describe bands broadening, when we exchange signs of $C$.

Fig 4.6 Chirped Gaussian Pulses
4.6.1 Nonlinear Phase Shift

Super-Gaussian pulse with large m can be used to represent rectangular pulses. Users are very easy to use. Just fill out the input fields and execute to see the output values as well as created graphical diagrams. Super-Gaussian pulse with large m can be used to represent rectangular pulses. m=1 for Gaussian pulse and m=3 for super Gaussian pulse. A sample output shown in fig. 4.7

Fig 4.7 Nonlinear Phase Shift
4.6.2 SPM frequency chirp

If dispersion is anomalous and non-linearity is present, the frequency chirps created two effects are opposite in nature. Users are very easy to use. Just fill out the input fields and execute to see the output values as well as created graphical diagrams. In the figure the frequency deviation is zero at the center of the pulse, it increases as we shift off center due to increase in the slope of the envelop reaches the maximum.

Fig 4.8 SPM frequency chirp
4.7.1 Input window for non linearity

When we use fiber length= 1Km and input Power = 0.00064watts, we get the following figures

Fig 4.9 Input window
4.7.2 Nonlinearity (Phase change VS distance travelled)

The phase change decreased with the distance firstly and then both increased. A sample output as shown in fig 4.10

Fig 4.10 Nonlinearity (Phase change VS distance travelled)
4.7.3 Nonlinearity (Phase broadening factor vs Number of steps)

The pulse broadening ratio decreased with the number of steps firstly and then both increased. A sample output as shown in fig 4.11

Fig 4.11 Nonlinearity (Phase broadening factor vs Number of steps)
4.7.4 Nonlinearity

Super-Gaussian pulse evolution in time and along the fiber. A sample output as shown in fig 4.12
4.7.5 Nonlinearity (increased Input power 0.64 Watts)

If we increase the power then we get the distorted the signal. If we not vary the fiber length (= 1 Km) and vary input Power (= 0.64 Watts) we get the following fig 4.13

Fig 4.13 Nonlinearity (increased Input power 0.64 Watts)
4.7.6 Fundamental Solitons

A secant hyperbolic pulse is launched inside an optical fiber, it can travel undistorted for infinite distance (of course in absence of loss). The fundamental soliton has a very special wave shape, the secant hyperbolic function. A sample output as shown in fig 4.14

![Fig 4.14 Fundamental Solitons](image)
4.8 Summary

MATLAB has powerful graphical tools and can produce nice output in both 2D and 3D. MATLAB is also a great tool for solving algebraic and differential equations and for numerical integration.

Different type of data can be input in the software, and then we get different form of graph. At the linear properties, the graph is exponentially decayed. Power is decreased with the travelling of light. Dispersion is increased with the increase of wavelength in the graph.

Nonlinear Phase Shift, Super-Gaussian pulse with large $m$ can be used to represent rectangular pulses. $m=1$ for Gaussian pulse and $m=3$ for super Gaussian pulse.

In the presence of non-linearity and dispersion, there is possibility of undistorted pulse propagation for infinite distance.
Chapter 5

Conclusion and Future Works

5.1 Conclusion

Our modern information-based world would not be conceivable without the tremendous achievements in optical communications over SMFs in the last three decades. Transmission rates over one SMF in the range of Multi-Terabits/s are state of the art; transpacific transmission distances without electronic data regeneration over more than 9000 km have been realized. Though optical fiber represents a transmission system of huge bandwidth, still it has various impairments like attenuation, dispersion, stimulated scattering, etc. In addition, the pulse propagation inside this transmission system is described by the nonlinear Schrödinger equation (NLSE) and NLSE incorporates almost all the properties of optical fibers. All the impairments of optical fibers are classified as, i) linear effects, which are wavelength depended, and ii) nonlinear effects, which are intensity (power) depended.

In this project, we have simulated the various linear and nonlinear properties of optical fiber with the aid of NLSE in a point to point optical transmission system. We have simulated the analytical results with some boundary conditions as well as solved the NLSE using split step Fourier numerical method.

Students often find certain concepts in fiber optic communication theory difficult to grasp. Our developed simulated programs provide easy means to educate students more efficiently in concepts that are traditionally difficult to teach at a blackboard using mathematical derivation. This system will help students to jump over the hurdle that an abstract physical concept presents and allows a further understanding of the issues of optical transmission system. In addition, simulation permits the students to observe the behaviour of systems that would be much costly to provide in a hardware-based laboratory.
5.2 Future works

This project work can be extended in a number of ways. The properties of the optical fiber as well as pulse propagation through it may be represented using animation. Computer animation has also become popular in academia because the common students are usually visually oriented. Furthermore, some concepts are simply easier to understand visually. With this motivation, a multitude of task may be carried out through simulation as well as animation to summarize,

- Investigation into advanced optical modulation and coding schemes.
- Optimization of the physical link-design including all relevant interacting linear and nonlinear effects
- Modelling and optimization of new optical transmission media (multi-core fibers, few-mode fibers, hollow-core fibers)
References